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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site. You can store your issues of 
MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from Mavericks) to have it appear on your iPhone and iPad (inside iBooks) 
next time you sync. Or print it out, even – and please feel free to pass MagBytes on. 
MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by Mac NZ for this purpose 
only. Find out more about the MagBytes Apple newsletter online (click on Mac NZ MagBytes Newsletter at top centre).

April 2016  
•2——Mac News ~ New 

MacBook, MacFamilyTree, 
WWDC 2016. 

•4——Updates ~ Office, 
Swift,QuickTime for Windows, 

Security Updates,  
GarageBand, Safari  
•5——Mac Help ~  

Around New Zealand 
•6—— iOS & iDevice news 

~ iPad Pro screen, Pegatron, 
Watch no flop, Earth Day,  

brush, iPhone SE, revenue, 
7nm, WhatsApp, poll 

•8——Tips & Tricks ~  
Extra-large section to make  

up for no March issue. 
•18——Shiny & New ~ 

FlexiHub, Lurmmen Mastering, 
reversible Mico USB,  
free MacPhun filters  

work in Photos

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

The updated MacBook has sixth-generation dual-core Intel Core 
M processors that go up to 1.3GHz (and Turbo Boost speeds up 
to 3.1GHz). They have faster 1866MHz memory; new Intel HD 
Graphics 515 delivering up to 25% faster graphics performance; 
and faster PCIe-based flash storage that makes everyday tasks 
feel snappier. 
The New Zealand recommended retail price starts at NZ$2399 inc. 
GST, and with a 1.2GHz dual-core Intel Core m5 processor with 
Turbo Boost speeds up to 2.7GHz, 8GB of memory and 512GB of 
flash storage for a recommended retail price of NZ$2899 inc GST. 
Apple also introduced the iPhone SE, essentially the goodness of 
the 6 line in a smaller, cheaper case. [Images: Apple Inc]

mailto:mac.nz%40me.com?subject=From%20MagBytes
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Mac News Updated MacBook faster, has one hour more battery life

New MacBook has improved features
Apple has updated its tiny 13.1 mm thick MacBook with 
the latest Intel processors, improved graphics, faster 
flash storage and an additional hour of battery life. 

61 Hurstmere Road, Takapuna 09 486 1493

Authorised to service iPod, 
iPad and Mac

www.istorenz.com

Enhancing Your Apple Experience

Scan QR Code to quickly 
get in touch with iStore

More news: www.mac-nz.co.nz
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Mac News WWDC 2016 ~ MacFamily Tree 8 at 50% off  for new version 

The all-metal unibody enclosure is now 
available in Rose Gold (to mere mortals, 
this is ‘pink’) as well – the first time on a 
Mac.
The updated MacBook features sixth-
generation dual-core Intel Core M 
processors up to 1.3GHz, with Turbo Boost 
speeds up to 3.1GHz; faster 1866MHz 
memory; new Intel HD Graphics 515 
that deliver up to 25% faster graphics 
performance; and faster PCIe-based flash 
storage that makes everyday tasks feel 
snappier. MacBook is available through 
Apple.com/nz starting today, and it will be 
in selected New Zealand Apple Authorised 
Resellers starting tomorrow (Thursday 
21st April). MacBook comes with a 1.1 GHz 
dual-core Intel Core m3 processor with 
Turbo Boost speeds up to 2.2 GHz, 8GB of 
memory and 256GB of flash storage for 
a recommended retail price of NZ$2399 
inc. GST, and with a 1.2 GHz dual-core 
Intel Core m5 processor with Turbo Boost 
speeds up to 2.7 GHz, 8GB of memory and 
512GB of flash storage for a recommended 
retail price of NZ$2899 inc. GST.
The ritual iFixit teardown that followed 
suggests the new model’s better battery 
life stems from a mix of optimisations and 
a slightly larger battery, and dramatically 
improved SSD speeds have been linked to 
an updated proprietary controller.

Hello – WWDC announced  
As scheduled, Apple has closed ticket 
lottery registrations for this year’s 
Worldwide Developers Conference 
takingplace from 13th June, and has 
already started sending out email 
confirmations to the lucky few selected 
at random to attend the event. This year, 
WWDC will highlight Apple’s four main 
operating systems, iOS, OS X, watchOS 
and tvOS, with attendees able to attend 
a series of lectures, hands-on labs and 
meetings with Apple engineers. This is all 
hinted at in the rather mysterious ‘code’ 
invitation (above).

MacFamilyTree reaches 8 
Happy birthday, MacFamilyTree, which 
has grown to version 8 — Happy birthday, 
MacFamilyTree, which celebrates its 18th 
birthday. In honour, Synium Software 

announced 
MacFamilyTree 8.0, 
an update to the 
genealogy software 
for OS X. The 
excellent software 
lets you explore 
your personal family 
history and discover 
your origins. Version 
8 assists data entry 
and researching 
your family tree, 
and offers dozens 
of printable and 
configurable charts 
and reports. 
It currently 
carries a 50% 
Update-Discount 
for everyone 
until July 17th 
whether you own 
a previous version 
or not: US$29.99 
(NZ$44.99) while  
MobileFamilyTree 8 
for iOS is available 
for US$9.99 in the 
App store. 
MFT8 is in the Mac 
App Store. 

mailto:mac.nz%40me.com?subject=From%20MagBytes
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https://www.ifixit.com/Teardown/Retina+MacBook+2016+Teardown/62149?utm_medium=email&utm_campaign=Retina%20Macbook%202016%20Teardown&utm_content=Retina%20Macbook%202016%20Teardown+CID_644106eac3764dd8621c32f53588f8fd&utm_source=CampaignMonitor&utm_term=Retina%20Macbook%202016%20teardown
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Big update to Microsoft Office 2016 for Ma
Do you use Microsoft Office 2016 for Mac? If you do, and you 
haven’t needed therapy, you’ll want to get the latest update 
– version 15.21.1– because it not only adds a lot of fixes and 
enhancements, but the Add-In Store for Word and Excel gets 
appended, too. To get the update, just open any Office app – 
Word, Excel, PowerPoint, Outlook or OneNote – and then choose 
“Check for Updates” from the Help menu. The update takes a 
while as all of the apps are receiving attention, but once it’s done, 
you can check out the products in the Add-In Store.

Swift
Swift, Apple’s programming language, grew swiftly in 2015, 
according Freelancer.com’s downlaodable PDF called Fast 50 
report.
The data comes from 1,429,842 
projects “filtered for spam, 
advertising, self promotion, 
reposts, or that are otherwise 
unlikely to be filled,” the 
published report says. Swift-
related jobs grew 566% year-over-year as more developers 
took notice of the newly open -sourced programming language, 
according to the report (via Apple World Today).

Goodbye QuickTime for Windows
Apple is “deprecating support” for QuickTime for Windows, and 
will no longer patch security flaws in the software. The company 
is also advising users to uninstall the media player from their 
Windows machines for security reasons.

Are you getting OS X security updates? 
Adam C Engst over at TidBITS.com wrote a nice little article 
called Make Sure 
You’re Getting OS X 
Security Data. You 
should probably read 
it; if you’re not going 
to, here’s the App Store 
System Preferences 
pane (right) showing 
the checkbox you really 
should enable to insure 
that OS X security 
updates are installed 
automatically.

GarageBand for Mac
Apple released a new version of GarageBand for 
the Mac, improving support for recent companion 
apps on iOS, and greatly increasing the number of 
samples available to musicians.

The updated software — v10.1.1 — can open Music Memos 
projects, and be controlled by the iPhone and iPad Pro versions 
of Logic Remote. Similarly, the software should also be better 
compatible with GarageBand for iOS and Live Loops projects.

Experimental Safari
Apple has launched a new developer-focused, experimental 
version of Safari for Mac, offering a sneak preview of features 
that may soon come to the browser for OS X and iOS.

Updates Microsoft Office ~ Swift ~ QuickTime for Windows ~ Security Updates

mailto:mac.nz%40me.com?subject=From%20MagBytes
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Apple support & AppleCare
Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Plus there’s Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. 
Every new Mac has a one-year warranty 
and 90 days free phone support. 
AppleCare extends this all out to three 
years. Under NZ law, you are covered by 
the Consumer Guarantees Act against 
anything going wrong that comes 
down to parts failure within reasonable 
expectations (say, inside three years’ use), 
but be prepared to spend anxious time on 
the phone, sticking to your guns to get it 
fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource. 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potters Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098
Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

Christchurch: With nearly 600 
members, this very active Apple-

Mac & iDevice training in Grey 
Lynn, Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac 
NZ – but I also run the Grey Lynn Sessions 
in Auckland (click on Training). This is the 
cheapest way to learn, at $40 per session 
in a friendly, group environment. A new 
series is starting Wednesday March 4th at 
7:30pm. Please email if you are interested 
in attending, as I only book a room when I 
can guarantee five attendees. The sessions 
are friendly, open to questions at all times 
and are backed up by handouts, and one 
is running now on Wednesday nights 
(7:30pm). I train (one-to-one at your home 
or workplace (in Auckland) for $95/hour. I 
also present to institutions.
Please email Mark for more info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top).

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help Apple assistance, Consumer Guarantees Act, help, support

focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news
iPad Pro and True Tone
Apple now has reason to nerd out over 
iOS colour management. With the 
launch of the miniature iPad Pro, that 
focus shifted toward the important-
but-impenetrable world of colour 
management. That’s because the new 
iPad Pro (it’s a little smaller than the 
original one) has the best screen ever 
seen in a handheld device. 

Pegatron still dodgy
One of Apple’s iPhone manufacturers, 
Pegatron, is still seeing its labour 
force put in excessive overtime — 
something unfortunately necessary 
for workers to meet basic financial 
needs, according to China Labor 
Watch.

No flop Watch
Despite contentious perceptions 
about the Apple Watch (high-profile 
VC Fred Wilson even called it a ‘flop’) 
analysts now reckon the company has 
sold 12 million to 13 million in the year 
since its launch (as noted by Seeking 
Alpha). That’s double the 6M iPhones 
that were sold in its first 12 months of 
sales …
And you can even play games on it. I 
know, that sounds crazy, but here’s 

New iPad Pro & colour ~ China labour ~ Watch no flop
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iDevice newsEarth Day ~ paintbrush ~ China ~ slim chip ~ WhatsApp ~ Poll

ten games you might consider if you’re one of those owners. 

Earth Day Video from Apple
‘Ask Siri about Liam’ ... Siri is, of course, Apple’s virtual assistant, 
and Liam is Apple’s recycling robot that helped the company 
recover 2204 pounds of gold in 2015 by dismantling iPhones 
(that’s a detail from the video at left). Siri asks Liam what he’s 

doing for Earth Day … 
(or try here on Apple’s 
YouTube channel).

iPad paintbrush 
The Monet Stylus helps 
you unleash the artistic 
potential of your tablet or 
other touchscreen device. 
It’s designed to feel like a 

paintbrush in your hand, allowing you to produce sweeping brush 
strokes as naturally as you would on a real canvas. 
It has a pressure-sensitive tip and a generous 165° writing angle. 
You can order this online, currently, with a discount.

iPhone SE ‘squeezing’ Asian marketshare
Chinese and Taiwanese smartphone suppliers are reportedly 
scaling back component production in the wake of Apple’s iPhone 
SE, which appears to be impacting the sales of other local 

smartphone brands. 
[The SE is a terrific iPhone is why – but think hard before buying 
the 16GB model.]

China’s quarterly iOS revenue up nearly 2.2x
This was mostly thanks to in-app purchases in mobile games, 
according to the App Annie Index Market Q1 2016, putting it 
ahead of Japan for Apple for the first time. 

7nm tech entering mass production in 2018
One of Apple’s primary chip manufacturers, TSMC, confirmed 
in a report to shareholders that it plans to trial 7-nanometer 
production in the first half of 2017, working towards mass 
production in the first half of 2018. [This means faster, smaller, 
leaner chips, power-wise.]

WhatsApp adds complete end-to-end encryption
Facebook has announced that WhatsApp, its popular (and free) 
mobile messaging service, is now using end-to-end encryption 
for all communications, not just one-on-one text exchanges and 
VoIP calls. That means even if a message could be intercepted, it 
would be utterly scrambled and meaningless. 

Take my poll, please
I came back wondering if it’s all worth it. 
Please take my poll and let me know what you think ...

mailto:mac.nz%40me.com?subject=From%20MagBytes
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tips&tricks
1/ Change your iDevice name — If your 
iPhone (or iPad) calls itself ‘iPhone’ instead 
of ‘[Name]’s iPhone,’ it’s not really a 
problem until you can’t find it and you’re 
having to shuffle through approximately 
thirty poorly named devices on the Find 
My iPhone app or on iCloud.com to try to 
find its location.
To change this on the iPhone or iPad, visit 
Settings>General>About. You can edit 
your device’s name at the very top (and 
while you’re there, you can also see all 
sorts of stats about what’s taking up your 
space). Once you update that info, iCloud.
com (and the Find My iPhone app) will 
reflect the change within a few minutes.
(On Mac, you can do this too, in System 
Preferences>Sharing. At the top of that 
pane, there’s a box for you to type into.)

2/ Block annoying people phoning you — 
There’s a simple way to block any number 
from contacting you in iOS. To do this 
in the Phone app, tap the ‘i’ next to the 
caller’s number under the ‘Recents’ tab 
or the ‘Voicemail’ one, then scroll to the 
bottom of the following screen and tap 
‘Block this Caller.’ Your device will warn of 
what you’re about to do.

3/ Block messages — You can block 
someone in the Messages app too –tap 

on the ‘Details’ button within the 
conversation, find that familiar ‘i’ (for 
Information) on the next screen, tap that, 
and choose ‘Block this Caller’ in the same 
way as above. Again, your device will warn 
you of what you’re about to do.
You can see everyone you’ve blocked under 
Settings>Phone, Settings>Messages, and 
Settings>FaceTime (they all reference the 
same list). If you tap ‘Blocked’ in any of 
those places, you can remove a caller from 
your list or add a new offender manually.
Note that your phone won’t ring when a 
blocked number calls, but the caller can 
still leave a message; however, since you 
won’t get a notification or anything, you 
won’t know a voicemail has arrived unless 
you check. The place to do that is within 
the Phone app under ‘Voicemail’ at the 
very bottom of the list, assuming your cell 
phone provider sports Voicemail.

4/ Backups take up space — If you’ve ever 
backed up your devices to iTunes (which I 
prefer to iCloud backups since my Mac is, 
in turn, backed up via Time Machine), it’s 
important to know those old backups may 
still live on your computer, and they could 
be taking up a ton of space, particularly 
if you have a space-challenged MacBook 
air, for example. Open iTunes and choose 
iTunes>Preferences from the iTunes menu 

at the top. When the Preferences window 
opens, choose the Devices tab (above). If 
you several backups in there, some may be 
for devices you no longer even have. Select 
one and click the Delete Backup button…

5/ Other settings — There are a 
other things you can do within this 
Preferences>Devices dialogue box (above). 
Right- or Control-click on a certain backup 
to see some handy options. For example, 
you can archive the backup to another 
device before deleting it. This creates 
date-stamped snapshots.
Show in Finder can be used along with 
Finder’s Get Info command to determine 
how big the backup in question is.
One more nifty thing you can do within 
Preferences>Devices is hover your cursor 
over any of the backups to see some 
information about the device it was made 
from (including the serial number).

Some settings, names, messages and fixes for iDevices
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Remove locations from images, Spotlight, smarter notes etc for Mactips&tricks
1/ Remove location info from your 
photos —  If you have posted photos 
online, those shot with iPhones , iPads and 
some cameras include data about precisely 
where they have been taken, depending 
on how you shared them. With privacy in 
mind, you should know the policies of any 
apps and services you use to share pictures 
and whether they automatically strip off 
Exif data when you upload. Facebook, for 
example, strips it then offers back the 
ability to indicate the general area, only, 
of where it was taken: ‘Masterton’, for 
example, rather than the GPS coordinates 
of your lounge. 
If you don’t know or can’t find out, though, 
Apple’s Mac Preview app (it’s already 
in the Applications folder of every Mac 
– I keep it in the Dock as it’s a brilliant 
program) can take that stuff right off of 
any images you want to share.
First, to check to see if an image has stored 
where it was taken, you can click to select 
it in the Finder and press Command-i. 
This’ll open up the item’s “Get Info” 
window, and you’ll see that listed if it’s 
included.
Open the picture you’d like to share 
into the built-in Preview program to get 
started; to do so, you may just need to 
double-click on your photo, as Preview 
is typically the default image editor on 

the Mac. If that doesn’t work, go to your 
Applications folder, launch Preview, and 
then either click “Open” on the window 
that’ll appear or choose File>Open from 
the menus to select the photo you need 
to work with, or simply drag-and-drop the 
image over the Preview icon in the Dock.
With the picture open, click on the 
Tools menu and choose Show Inspector. 
Underneath the ‘i’ tab, the Inspector 
window will show a GPS option if that data 
is present. Choose it and click Remove 
Location Info to do just that.

When you save your changes, your image 
will be ready to share, all locatable data 
removed. 

2/ Photos has some Exif abilities too, 
now — When viewing a picture in Photos 
you can, in El Capitan, now click the info 
button to edit geotags as well. Simply 
relocate the pin to a new spot by clicking 
and dragging it. 
If your picture doesn’t have a location yet, 
you can choose Assign a Location to add 
this data yourself.
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tips&tricks Friendlier Spotlight, smarter Notes  |  Transferring files

3/ Spotlight now uses natural language 
— It’s not just Siri that has become more 
intelligent. With Spotlight, the search 
engine built into Mac OS X, you used to 
have to turn on all sorts of fields, like ‘file 
size’, do do detailed searches, and you can 
still do that (try Command F while in the 
Finder) but now Spotlight also has the 
natural language features. 
Spotlight interprets meanings to give you 
more accurate results, such as files you 
worked on a week ago when you want to 
continue a project. 
A small but very welcome improvement 
is that you can also move the Spotlight 

window around and, once the window 
is showing results, you can resize the 
window’s height to show more, which is 
important now that Spotlight can search 
many more sources, including some online 

services like live weather.
On your Mac, Spotlight can now 
understand, for example, a search query 
like “Get Mail from Brian about football” 
and it will bring up exactly what you’re 
looking for.

4/ Smarter Notes even tracks flights — 
Notes really got beefed up in Mac OS 10.11x 
‘El Capitan’, letting you drag in images, 
links and sketch directly. 
But it also makes it easy for fliers to track 
flight information. All you have to do is 
type your flight number into the Notes 
app, hit enter, and it will be highlighted 
in orange. Click the link and it’ll show you 
a map of your flight path and estimated 
arrival time. (Here’s the full walk-through 
on how to use it.)

5/ Instant Mission Control — You’ve 
probably done this by accident in 
El Capitan. Here’s how and what’s 
happening: a new gesture for opening 
Mission Control cuts the number of steps 
for moving a window to a new space. Now 
you just drag it past the top of the screen.
The Spaces bar at the top of the screen has 
changed to initially display only the names 
of your desktops and full-screen apps. This 
gives more space for the window previews 
underneath. 

1/ File Sharing between Macs — The basic 
way to share files between Macs is to use 
File Sharing. To use this feature, you must 
activate it in the Sharing pane of System 
Preferences.
If you want to only share specific folders, 
or allow certain users to access them, add 
folders to the Shared Folders list, then 
select a folder and add users in the Users 
list. (If not, any user with an account can 
access your files.)
To access another Mac’s files in the 
Finder, choose Network from the Go 
menu, double-click one of the computers 
or devices that displays, and enter your 
username and password. You can then 
browse that Mac’s folders and files, and 
drag files to and from that computer.
... (continues)
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tips&tricks File transfers continued — Mac to Mac, Mac to iDevice; iOS to iOS

2/ AirDrop — In the Finder, choose 
Go>AirDrop on both Macs; the one you 
want to send files to, and the one you’re 
sending from. 
Drag a file onto the icon of the computer 
you want to send a file to. Unfortunately, 
AirDrop isn’t always reliable, and it 
does need to be active on both Macs, so 
you can’t easily copy files to a server or 
other computer, but it can be easier that 
messing with File Sharing if you only need 
to send files occasionally. [It’s great when 
it does work.]
3/ Email — If you have one or more small 
files you need to send to another Mac, 
you can send them as attachments to an 
email message. Just create a new message 
and address it to yourself, and then add 
the files. When you get to your other Mac, 
open your email client and download the 
message and its files.
This is a good way to send files to a Mac 
that’s not currently running.

4/ iCloud Drive — Apple’s iCloud Drive is 
mostly designed for apps to store files, but 
you can add files to it as well, which you 
can later access from another Mac. Choose 
Go > iCloud Drive in the Finder, and you’ll 
see a number of folders. Just add a file to 
the top level of the iCloud Drive hierarchy 

or create your own folder, and you’ll be 
able to access the file on your other Mac. 
This works best for small files, as well 
as files you may want to access on iOS 
devices.

5/ Dropbox — If you use Dropbox (free, 
but you can pay to add more storage to 
the default 2GB) to store some of your files 
in the cloud, it seems obvious that you 
can easily transfer files from one Mac to 
another by placing them in your Dropbox 
folder. 
But you may think that, when you need to 
transfer large files, such as videos or large 
software installers, it isn’t practical to 
put them in the cloud and then download 
them.
Dropbox has a feature called LAN Sync 
that allows Dropbox to sync them across 
your network to other devices. It still 
uploads them, but if you have a bunch of 
files to transfer from different folders, just 
drop them all in a Dropbox folder, and let 
them sync to the other devices. 
When you’ve got the files on the second 
Mac, move them out of your Dropbox 
folder, so they don’t stay in the cloud. 
Unfortunately, this feature isn’t always 
reliable, so it may not work for you. 
Dropbox also lets you send files between 
Macs and PCs and other devices, which 

can be super-useful.  [These came from 
Macworld, which adds a few more 
suggestions.)

Transfer between Macs and iPads/
iPhones/iPod touch: 
1/ AirDrop — AirDrop is Apple’s 
technology for sharing files across devices. 
You can use it to transfer files from one 
Mac to another, but also use it to transfer 
files from a Mac to an iOS device, or from 
one iOS device to another. On your Mac, 
choose Go>AirDrop in the Finder (or 
click it, if it’s visible, in folder sidebars), 
and then, on your iOS device, make sure 
AirDrop is activated in the Control Center 
(swipe up from the bottom of the screen 
to access this setting). You can choose 
to allow transfers from Contacts Only 
or from Everyone; it’s safer, of course, to 
choose the former.
Your iOS device needs to be awake for 
AirDrop to be active. On the Mac, drag a 
file onto the icon for your iOS device in 
the AirDrop window. On your iOS device, 
you’ll see a menu offering to open the file; 
this menu lists the apps that can open the 
file type.
For some types of files, AirDrop isn’t very 
helpful. For example, if you try to send an 
AAC audio file from a Mac to an iPhone, 
the latter offers to open it with apps such 

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes


>>

>
>

Mac NZ

page

12

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2015. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip Enterprises 
2010-2015.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission,   
email 
Mac NZ 

MagBytes
#74

tips&tricks File transfers continued — iOS to iOS; iOS to Mac and back

as Voice Memos, Evernote, Dropbox, etc 
but not with the iOS Music app, or other 
music player apps.

2/ Email — Using email is a another way 
to send small files to an iOS device. Just 
create a new email addressed to yourself 
and add the file(s) as attachment(s) to 
the message. Tap the attachment in the 
message to download and then open the 
file. 
Depending on the file type, you may or 
may not be able to open files on your 
device. Naturally, you’ll want to do this 
when you’re on a Wi-Fi network to avoid 
potentially using a lot of cellular data if 
you’re sending large files.

3/ Dropbox or other cloud services — If 
you have the (free) Dropbox app on 
your iOS device (or apps for other cloud 
services, such as Google Drive, Box, etc) 
you can add files to your cloud and then 
access them on your iOS device. As with 
email, you’re limited as to which types of 
files you can open. 
If there are specific files you need to access 
on your iOS device, you may need to find 
apps that can read them. For example, 
if you need to read Excel spreadsheets, 
you’ll need either Microsoft Excel for iOS, 
Apple’s Numbers, or another app that can 

view (and perhaps edit) these files.

4/ iCloud Drive — Apple’s own iCloud 
Drive is a bit different from the other cloud 
services. It stores files that you’ve opened 
with specific apps in dedicated folders. You 
can add a file to iCloud Drive and create 
your own folders, or just copy files to the 
top level of iCloud Drive. 
To do this on your Mac, choose Go>iCloud 
Drive in the Finder (or click it in the sidebar 
of folders if it’s there), then add the files to 
the location you desire. 
If you’re adding a file that you can open 
in a specific app that already has a named 
folder, you can add it directly to that 
folder. On iOS, either open the app that 
can view the file, or open the iCloud Drive 
app, tap the file, and then tap the Share 
button to see your options for opening 
the file.

5/ iTunes File Sharing — Some iOS apps 
can use iTunes File Sharing, a rather odd 
(and unexpected) way of adding and 
managing files in iTunes so these apps can 
access them. It’s clunky and has largely 
been superseded by AirDrop, but it still 
works.
To use iTunes File Sharing, connect your 
iOS device to your Mac, select it in iTunes, 
and then click Apps in the sidebar. When 

Lock down your Mac, iPhone, and online 
accounts if you expect trouble ahead, or 
you’re about to go travelling: 
1/ Tune up — Mac and iOS users can be 
a bit smug about the security of their 
devices – often, that’s justifiable. But 
because of Apple’s architecture, there’s 
little to nothing you can do in iOS, and 
little to nothing that’s useful in OS X.
So don’t open email you don’t recognise, 
and if you do, certainly don’t click any links 
or open any attachments.
Don’t click links on dubious-looking 
websites.
Don’t accept messages in iOS or OS X to 
install ‘custom profiles’ when you haven’t 
sought them out.

you click Sync at the bottom of the 
window, iTunes will copy that file (as well 
as copy any other items selected to sync, 
such as music, apps, etc.). 
You can also delete files by selecting them 
in the File Sharing dialogue and pressing 
the Delete key.
With some apps, you have to click + or 
Import, and choose to import the file(s) 
from iTunes. This is the case even if the 
files have been copied to your iOS device. 
Other apps may show the files 
immediately.
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tips&tricks File transfers Backups, space & more

2/ Monitor your Macs — In OS X you 
can install software that monitors 
what is talking to your computer and 
what services your computer might be 
accessing. There’s the Internet Security 
X8 package from Intego and Objective 
Development’s Little Snitch, for example.
[I don’t personally use these myself on the 
premise that if there’s real malware for 
Mac, it will been the news and it would 
be such a surprising event, and then I’d 
act accordingly, meaning I avoid the 
intrusion and system performance hit in the 
meantime.]
Little Snitch lets you know which apps are 
trying to access the Internet and why. This 
can be useful when you’re on networks 
you don’t know and trust (ie when you’re 
travelling), so you can see the kinds of 
behaviour originating from the network 
around you — and potentially alert a 
café owner or a store manager if you see 
someone engaged in malicious activity.

3/ VPN — Using a virtual private network 
(VPN) whenever you’re outside your 
comfort zone — which can include some 
kinds of activities on your home network 
— effectively locks down your internet 
traffic to anyone who can intercept data 
over a local Wi-Fi or Ethernet network and 
at points between that and the other end 

of the VPN connection in a data centre 
somewhere. None of this assures that 
people can’t break in, but it reduces points 
of weakness, and that’s always good. [I 
found VPN Unlimited and bought a several-
year subscription when it was offered at a 
discount.]

4/ Lock down — Everywhere you can, 
enable two-factor authentication (2FA) 
or token-based logins. Most cloud-based 
and social-networking services now offer 
some variant of it. Apple’s 2FA, upgraded 
last year, relies on sending information 
to iOS or OS X devices registered to the 
same Apple ID, and using SMS or voice as 
a fallback. 
A second factor prevents someone who 
obtains or guesses your password from 
using that from anywhere in the world 
to log into your account. If your services 
offers login alerts, which warn you 
whenever a new device is added or a login 
occurs, enable that too.

5/ The Social Network(s) — Check all 
social networking, email, financial, and 
other services you use beyond 2FA to 
examine privacy options. Some networks 
will let people who have some information 
about you find out more (‘social mining’), 
or look you up by email address even if 

there’s no public listing that associates 
you. They may be able to let a friend of 
a friend to obtain your phone number 
or physical address; you might consider 
wiping that data or further restricting it. 
Even Facebook now supports two-factor 
authentication (that’s why it wants your 
phone number).
Glenn Fleishman also recommends 
changing your passwords comprehensively 
across all services you use. While it’s a 
pain, if you either can’t recall the last time 
you swapped a password, or you use the 
same password at multiple sites, the time 
is ripe.

How to back up and restore an iPad 
differently:
1/ Swap backup types — You can swap 
to an iCloud backup with a single flip of a 
switch. You can switch from an iTunes to 
iCloud backup at any time. If you have only 
the free 5GB iCloud service, you may have 
to bump up to a paid tier to have enough 
storage, however. The iCloud backup 
doesn’t count any Apple-purchased or 
Apple-cloud-stored data as part of the 
backup size, but it can still easily exceed 
5GB. Go to Settings>iCloud>Backup, 
and flip the iCloud Backup switch to on. 
Backups occur automatically when an 
iOS device is on Wi-Fi and plugged in, 
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but you can also tap Back Up Now from 
that setting screen to force an immediate 
backup.
There’s some risk that if you have content 
stored uniquely on your iPad that you’re 
not sure you have anywhere else that you 
won’t be able to recover it. That seems 
unlikely these days, given that most apps 
let you sync data through iCloud Drive, 
Google Drive, Dropbox, and other services, 
or are working off a copy stored elsewhere.
One place iTunes shines over iCloud 
backups is that any app downloaded via 
iTunes gets restored locally instead of 
having to come down again from the 
cloud. [Even more detail at Macworld.]

2/ Switch apps on an iPhone 6s or 6s Plus 
without touching the home button — 
Press and swipe from the left edge of the 
screen to switch to the next app (this only 
works on the Force Touch enabled iPhone 
6s and 6s Plus).

3/ Pair a Siri Remote with a 4G Apple TV 
— Sometimes a Siri Remote stops working. 
You’re sure it has a good battery charge, 
but it may have become unpaired with the 
4G Apple TV. Place the Siri Remote within 
75 mm of the Apple TV and point it at the 
Apple TV.
Hold down the MENU and VOLUME UP 

buttons together for 5 seconds. (These 
buttons are placed diagonally from each 
other, so you might need two hands.)
Quickly look at the top righthand side 
of your TV screen. If all went well, you’ll 
see a message ‘Remote Connected’; this 
message disappears after a few seconds.

4/ Night Shift — The new iOS release, 
9.3, introduces Night Shift, a new setting 
that warms up the display colours on 
your iPhone or iPad so that the blue light 
element of the display doesn’t keep you 
awake at night. Even though the actual 
science behind this is not yet conclusive, 
it’s a more pleasant way to use your phone 
right before bed. Open settings, tap 
Display & Brightness and enable it; the 
setting can choose the sunrise and sunset 
times as they change with the seasons or 
set your own schedule.

5/ Lock notes — You now have the ability 
to add a password lock in the Notes app. 
Once you set a password for Notes, don’t 
forget to click on the actual lock icon to 
keep your most precious (or embarrassing) 
ramblings private.

6/ Stills from Live Photo — In iOS 9.3, now 
you can extract the still image from any 
Live Photo. In the Photos app, simply pull 

up the Share sheet, and you will now get 
the option to duplicate the Live Photo or 
just the still image.

7/ How to force restart an Apple Watch 
— If you ever find your Apple Watch 
unresponsive, press and hold the side 
button and the digital crown until it 
restarts.

8/ Launchpad on Mac — Launchpad is a 
slightly neglected OS X feature that shows 
a visual, iPad-like display of available 
applications on your Mac. I don’t use it, 
myself., If you do, some improvements 
were made to the interface, then it stalled 
…
With Launchpad active (it’s an app in your 
Applications folder, if you can’t see it in 
your Dock), you can just start typing — you 
don’t need to move the cursor into the 
search field — and the app shows matching 
items, which you can mouse or arrow 
through to select and run. [Note this also 
works in the Applications – and any – 
folder. Know a folder or app starts with 
‘w’? Type ‘w’.]

9/ Build your own custom on-screen 
buttons for iPhone and iPad — Why not? 
There are 13 more actions available when 
you tap that Plus button.

tips&tricks A potpourri of  odds and more odds (extra to make up for March)
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Right-oh, I’m off overseas from next week 
for on month, going on an adventure 
(a battlefield tour and some historical 
research), so not only will there be very 
few Mac NZ posts after Tuesday, there 
will be no tips on Fridays until the week 
of April 5th and not even a MagBytes 
magazine. Sorry! So here are a few extra 
tips to help you cope, and the April 
MagBytes will be bigger than usual.
First, some Mac tips.

10/ Copy and paste addresses in a single 
step in El Capitan’s Contacts — If you 
have a full address copied, you can now 
paste it all in, in one step, instead of street 
into the street field, suburb to line 2 etc. 
Insert the cursor on the Street Address 
field and paste: everything now goes 
where it should go in one fell swoop.
As noted above, when Apple added data 
detectors in Mail – and to a much lesser 
extent Safari – I didn’t have to do the 
copy/paste dance as often, but every once 
in a while, you’d still get an address you 
needed to add to Contacts by copy/paste.

11/ Smart Folders in the Finder’s sidebar 
— We used to have ‘today, yesterday, 
last week…’ on the Finder sidebar. These 
pre-fab options disappeared a couple 
of releases ago but you can recreate the 

feature. In the Finder, choose File>New 
Smart Folder.
In the upper-right corner, click the + sign. 
A row of choices appears. Select Created 
Date from the first menu, then Yesterday 
from the menu following the word “is.”
Click Save, name it “Yesterday” and leave 
the Add To Sidebar box checked.
Click Save.
Now that set of matches appears as a 
smart folder you can click in the sidebar. In 
this case, I chose Created Date, since that’s 
the most likely criterion you want to find 
files from yesterday.
If you want to use a different way of 
determining that something happened 
to a file or other item, from the first field, 
select Other, then choose Date Added, 
Date Last Viewed, Last Modified Date, or 
other criteria. It can be instructive to try 
different date selectors to see which one 
fits best.
You can always add additional criteria to 
that smart folder, if you want to exclude 
email messages or other items from your 
yesterdays. (From Macworld.]

12/ Cleaning up your Finder’s Sidebar — If 
you never use AirDrop, All My Files, or 
iCloud Drive, you shouldn’t need to see 
them whenever you open a Finder window. 
You can drag some individual items out of 

the list to remove their shortcuts.
Secondly, hovering over any of the 
subsections (like Favorites, Devices, or 
Shared) will let you hide the items within 
it without removing anything.
Finally, you could also go to 
Finder>Preferences>Sidebar and uncheck 
anything you don’t want showing up. This 
way you can always turn them back on.
Additionally, you can hide the sidebar 
completely under the View menu if you 
want. This is kind of the ultimate cleanup, 
isn’t it?

13/ Change your Mac’s default Web 
browser — If you’d like to change your 
Mac’s default browser, open System 
Preferences (look in the Apple menu if 
you don’t know where to find it), then 
click General. Next, find the pop-up menu 
labelled “Default web browser:” Click it, 
then choose whichever browser you’d like 
to use as your default.
But be aware that the Default web 
browser menu lists any app on your 
computer that can open Web pages, even 
if they aren’t necessarily a Web browser, 
per se.

14/ Change your Mac’s default email 
app — To change your email client, you 
still need to do so through Apple’s Mail 
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app. Open Mail, then choose Preferences… 
from the Mail menu. Click General, then 
select a new email app from the Default 
email reader pop-up menu.

15/ Remove app purchases from iTunes 
— Apps associated with an iTunes account 
should only appear there if they were 
obtained for free or purchased. But it’s 
possible that you or someone in your 
family selected apps by unintentionally 
clicking, or the apps are from so far in the 
past, you forgot you ever bought them. Or 
maybe they’re so old you just wouldn’t use 
them any more anyway.
In iTunes for OS X, choose Store View 
Account, enter your account password, 
and then scroll down to select See All 
under Purchase History. (These receipts 
don’t show the device they were bought 
on, though. For that purpose you have to 
consult your original emailed receipt.)
To remove, you can hide them from 
appearing. Here’s how in iTunes for OS X:
In the upper bar near the right, click your 
name and select Purchased.
Enter your account password if prompted.
Click Apps at the upper right and then, 

in the middle, click All (as opposed to On 
This Machine).
Hover over any app, and an X will appear in 
its upper-left corner.
Click the X, and you’ll be prompted to hide 
the purchase.
Repeat 4 and 5 as necessary.

16/ Delete photos in iOS even when the 
trash can icon is greyed out — There 
seem to be a few different causes for this 
problem, which typically arise if an iOS 
device has been synced to iTunes – either 
the iOS device with the trash-can issue or 
a different one that was backed up and 
restored to that problematic device. In 
both cases, you may need to erase the 
current contents of the iOS Photos library 
in the steps that follow, so you should 
make sure you have a complete backup of 
all the multimedia you want to save. (If 
you’re already syncing photos with iTunes 
on a Mac or PC and you’re sure you’re up 
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to date, that’s likely what’s preventing you 
from deleting images in iOS.)
If you’re not already using iTunes, 
use iPhoto, Photos, or Image Capture 
to retrieve all the images from your 
device, even if you only need to do that 
temporarily. After being sure your photos 
are completely backed up onto your Mac …
Connect your iOS device via USB to iTunes 
on a Mac (or PC).
Authorize the device if prompted.
Select the device in iTunes, and then click 
the Photos item in the Settings navigation 
bar.
Check the Sync Photos from the box and 
click Apply at lower right. (If Sync Photos is 
already checked, see below.)
You’ll be prompted to replace the library 
on your mobile device. Agree, but please 
recognise this wipes out all the photos in 
iOS.
This will clear whatever state was stuck 
related to the iOS device. If you don’t 
want to continue using iTunes for syncing 
photos, uncheck Sync Photos, click Apply, 
and the iOS device should be free of that 
unwanted burden.
If you’ve synced with iTunes in the past, 
follow steps 1 and 2 above, but in step 3 
you should see a check mark next to Sync 
Photos. If not, check it and click Apply. 
Some iOS users report that this seems to 

update sync status without prompting a 
warning – that is, their device was previous 
syncing via iTunes, but not reporting it 
correctly, and checking the box doesn’t 
warn them that the library will be wiped 
from iOS.
You can now uncheck albums and other 
kinds of photo items in iTunes and click 
Apply to delete those items; or uncheck 
Sync Photos, click Apply, and liberate 
iOS. I, for example, just sync one album 
to my iPhone: Family, so I can show 
people pictures of my favourite people 
when I’m travelling. (Apple has more 
detailed instructions on general use of this 
feature.)

17/  Using ‘Paste and Search’ in Safari for 
iOS — If you’ve copied some text on your 
iPhone or iPad and you’d like to search the 
Web for it, there’s a little-known feature 
that’ll let you do that very quickly. All you 
need to do is go into Safari, tap the search 
bar at the top if it’s not already visible (like 
if you’ve scrolled down on a page), then 
press and hold there for a moment to get a 
new menu to pop up.
Tap the Paste and Search option that 
appears, and your copied text becomes 
your new Web search. (If what you copied 
was a URL, though, the command will read 
‘Paste and Go’ instead.)

That menu will also let you copy what’s in 
the search bar or have your device speak 
its contents aloud.

18/ In iOS, add quick shortcuts and an 
on-screen Home button —
If your iPhone’s Home button is broken, 
you can enable Assistive Touch from 
Settings>General>Accessibility and 
you get a floating button which persists 
wherever you are in the system (though 
you can drag it around out of the way). Tap 
it, and you get access to a special pop up 
menu of options, one of which by default 
is the Home button.

19/ Build your own palette of useful 
shortcuts — You can even defining custom 
gestures, and 
if you have an 
iOS device that 
supports 3D 
Touch, you can 
define an action 
for a hard press 
on the floating 
button. Again go 
to Settings>General>Accessibility, turn 
on Assistive Touch and tap Customise Top 
Level Menu. Under Create New Gesture 
you can really go crazy, including adding 
Force Touch actions.
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FlexiHub ~ MicFlip Micro USB ~ Lurssen Mastering Console ~ FiltersShiny&New
FlexiHub
If you need to access devices plugged 
into a Mac from a  distance, using 
another Mac, FlexiHub gives you the 
ability. Almost anything plugged in 
via USB can be accessed, including via 
Windows PCs and Android devices. 
Once an iOS app is available, this 
will be even better. There’s a free 
30-day trial to see if it’s something 
for you; after that, there’s a range of 
subscription options. 

Lurssen Mastering Console
Mastering is a dark and difficult art, but it makes a huge 
difference to a musical project and makes a track shine. If you’re 
a Garageband 
user, you can now 
just expert your 
song and run 
it through the 
Lurssen Mastering 
Console by IK 
Multimedia and 
you’ll get all the 
benefits without 
the pain. It comes 
with a list of 
proven profiles for 
you to deploy and 
tweak on Mac or iPad ... for €239.99.

MacPhun Filters 
for Photos
Filters for Photos is 
a new, free app that 
works standalone and 
also within Photos as an 
Extension. You can add 
30 new filters to photos 
with a single click. It 
also integrates with the 
Photos for Mac. Once 
you’ve installed Filters and dragged the expanded App to your 
Applications folder, open Photos, select a photo, choose Edit and 
click Extensions down the bottom to turn them on. When you 
register with your email address you unlock 15 more filters.

MicFlip reversible Micro USB plug
WinnerGear is trying to do for the Micro-USB what Apple 
achieved with the Lightning connector – make a connector 
that doesn’t need to 
be a certain way up to 
mate. These strong, 
braided cables have 
gold-coated reversible 
plugs. It doesn’t work for 
everything – for example, 
not with the musical 
keyboard I tried – but it 
will take the connecting 
pain out of many other 
operations. US$20 each, 
in three colour combos. 
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